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Copyrights and Trademark Notices
Copyright © 2024 Telestream, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, Vantage Cloud, CaptureVU, 
FlexVU, PRISM, Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of 
Telestream, LLC and its Affiliates. All other trademarks are the property of their 
respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2016|Server 2019|Server 2022, Windows 10, 
Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 2012|2016|2019|2022, 
and Windows Media Technologies are trademarks of Microsoft Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.
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ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.
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MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.
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Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 
Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 
61000-4-4, EN 61000-4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE 
Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Configuring Job Status 
Views

Job Status Views is a web application that provides operators and managers with job 
status information that focuses on jobs, rather than the comprehensive system point of 
view offered by the web Dashboard. Using the Vantage Management Console, you can 
configure views, which define what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows. 
You can create additional views that represent a single workflow, and those views can 
be configured as public or private. Public views are available to all Vantage users, and 
private views are available only to approved users.

Note: For a comprehensive overview of the Job Status Views web application 
program, see the Vantage User Guide.

Topics
■ Displaying the View Configuration Panel

■ Enabling and Disabling the All Workflows View

■ Creating a New View

■ Renaming a View

■ Duplicating a View

■ Deleting a View

■ Selecting and Changing the Workflow for a View

■ Displaying All Jobs or Only Jobs in Process

■ Enabling Options

■ Choosing the Display Columns

■ Configuring Permitted Users

■ Refreshing the View List

■ Exporting and Importing Views
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Displaying the View Configuration Panel
To view the view configuration window, open Application Configurations in the 
component panel and select Job Status Views. The Vantage Management Console 
displays the Job Status Views detail panel shown here:

Enabling and Disabling the All Workflows View
When you enable the All Workflows view, any Vantage user with access to this view sees 
information on all workflows in the domain. When this view is disabled, no user can 
view information on all workflows.

To enable or disable the All Workflows view, do this:

1. Display the Job Status Views details view.

2. Select the All Workflows view.

3. Check (enable) the Enable check box below the Description to enable viewing all 
workflows, or uncheck Enable to allow viewing only selected workflows.

4. Click the Save button .

Creating a New View
To create a new view, do this:

1. Display the Job Status Views details view.

2. Click the Create Configuration button  (or right-click in the empty workflow lists 
space and select New Configuration).
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3. When the Select Workflow dialog displays, select workflows for the view (Ctrl-click 
to select multiple workflow), and click OK.

4. Optionally, enter a description in the Description text field.

5. Click the Save button .

Renaming a View
To rename a view, do this:

1. Display the Job Status Views details view.

2. Select the view to rename.

Note: You cannot rename the All Workflows view.

3. In the Name text box, enter a new name for the view.

4. Click the Save button .

Duplicating a View
To duplicate a view, do this:

1. Display the Job Status Views details view.

2. Select the view to duplicate.

Note: You cannot duplicate the All Workflows view.

3. Click the Duplicate button  (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate view.

5. In the Description text box, enter a description for the duplicate view.

6. Click the Save button .
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Deleting a View
To delete a view, do this:

1. Display the Job Status Views details view. 

2. Select the view to delete. (Ctrl-click or Shift-click to select multiple parameters.)

Note: You cannot delete the All Workflows view.

3. Click the Delete button  (or right-click and select Delete).

4. When the confirmation dialog displays, click OK.

Selecting and Changing the Workflow for a View
To change the workflow for a view, do this:

1. Display the Job Status Views details view.

2. Select the view to modify.

Note: You cannot change the workflow displayed in the All Workflows view.

3. Click the Workflows tab, and select workflows to move. Move workflows from the 
right panel to the left to remove them from the view, or left to right to add them.

4. Click the Save button  to save the changed view.
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Displaying All Jobs or Only Jobs in Process
You can configure each view to display all jobs or only the jobs that are currently in 
process. When configured to display only in process jobs, jobs that are in any other state 
(completed, failed, stopped by user, etc.) do not display. Some people might prefer to 
view all jobs, while others prefer to view the shorter list of in process jobs.

To configure the scope of jobs for a view, do this:

1. Display the Job Status Views details view.

2. To display in process jobs only, check the Show Only “In Process” Jobs check box.

3. To display all jobs, clear the Show Only “In Process” Jobs check box.

4. Click the Save button .

Enabling Options
You can configure each view to permit operators to use Job Status Views to control jobs 
with the Stop, Restart, and Delete functions or restrict access to those functions. 

To enable or disable Stop, Restart, and Delete for jobs in a view, do this:

1. Display the Job Status Views details view.

2. Check Options check boxes as preferred to enable (checked) or disable 
(unchecked): Show Only In Process Jobs, Allow Stop, Allow Restart, Allow Delete, 
and Allow Set Priority.

3. Click the Save button .

Choosing the Display Columns
Every view displays the Job and State columns. You can configure views for individual 
workflows to include columns, such as workflow name, progress, started, updated, and 
to allow users to perform actions such as stop, restart, delete, and so on.

When you choose to display a column for a workflow action, the column displays the 
state of that action. This can help you use Job Status Views to view the state of actions 
during workflow processing.

To define which columns appear in a view, do this:

1. Display the Job Status Views details view.

2. Select the view in the Configuration list to modify.

3. In the lower panel, select the workflow to which you want the view to apply.

4. In the Columns row, check (display) the columns you want to display: Workflow, 
Total Progress, Started, Updated, and Expires.

5. Click the Save button .
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Configuring Permitted Users
You can configure a view to be available to individual users or Everyone (public).

Note: Users with administrative privileges will have full access whether or not they 
are given permission.

To define which Vantage users can access a view, do this:

1. Display the Job Status Views details view.

2. Select the view to modify.

3. Select the Permitted Users tab.

Note: The Permitted Users tab is available only if you select Enable User 
Administration in the Vantage Management Console Settings & Options.

4. To make the view available to all Vantage users, do this:

a. Check the Everyone (Public View) check box.
b. Click the Save button .

5. To make the view available to select Vantage users, do this:

a. Clear the Everyone (Public View) check box.
b. In the Available panel, select the users who should have access, and click Add.
c. In the Visible to user panel, select users who shouldn’t have access; click Remove.
d. Click the Save button .

Refreshing the View List
When you open the Job Status Views detail panel, the Vantage Management Console 
displays the current view configuration. If another administrator is making changes 
(such as adding Vantage users), you must refresh the display to see those changes. To 
refresh the display, click the Refresh button .

Default description
Enable
Options
Columns

Permitted Users

Permit Everyone
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Exporting and Importing Views
Vantage allows you to export views to XML files, which you can then use to import the 
same views into another Vantage domain.

To export views, do this:

1. Select the view to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button  to export selected views (or right-click and select Export, 
or select Export all from the Export button menu).

3. Use the file system dialog to save the exported views.

The default file name is the view name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the view in 
the XML file.

To import views, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the view file to import, then click 
Open.

Note: If you try to import a view that is already in this Vantage domain, Vantage 
prompts you to cancel or confirm replacement.
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Monitoring Workflows and 
Managing Jobs

The topics in this chapter describe how to submit jobs, monitor workflows, and manage 
jobs in Workflow Designer.

Topics
■ Submitting Jobs to Workflows

■ Monitoring Workflow Status & History

■ Monitoring and Managing Jobs

■ Generating Job Reports Manually

■ Managing Job Report Configurations

■ Viewing the Domain Summary

■ Viewing Binders and their Assets

■ Controlling Action Execution in Jobs

■ Viewing Action Status and History

Note: In addition to manually starting jobs directly in Workflow Designer, you can 
also submit jobs by dropping media files into target directories or by using Dublist 
Portal and Workflow Portal clients. You can also submit jobs from other programs 
using the Vantage SDK. 

Note: You can also monitor and manage jobs using the Job Status Views web 
application. See Using the Job Status Views Web Application.
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Submitting Jobs to Workflows
This topic discusses the various methods used to submit media or other types of files to 
Vantage workflows for processing. You can submit jobs in the following ways: 

• Directly in Workflow Designer using various methods. See Manually Submitting Files 
Directly in Workflow Designer, following.

• Automatically, by adding files to directories monitored by active workflows.

• As a batch, by submitting a workorder file to a Workorder-based workflow. See Sub-
mitting Multiple Files in a Batch, following in this topic.

• From Workflow Portal client applications. See Using Workflow Portal and Workflow 
Portal Web Application.

• From Dublist Portal. See the TrafficManager User Guide.

• From third-party or custom programs using the Vantage SDK.

Manually Submitting Files Directly in Workflow Designer
To submit files manually to a workflow for processing directly in Workflow Designer 
(which starts a new job for each file submitted), do one of the following:

• Drag and drop the selected file or files from a Windows Explorer directory directly 
onto the origin action of the target workflow. See Submitting Files via Drag and 
Drop.

• Select the workflow and click the Submit Job button. See Submitting Files via the 
Submit Button.

Note: The file(s) you submit aren’t always media files; though they commonly are. You 
can manually submit any file that the workflow can process. It might be an XML file 
(metadata, for example). Or, it might be a workorder file for a Workorder action 
workflow, for submitting several jobs at once. It also may be some other form of file, 
based on your workflow.

Submitting Files via Drag and Drop
To submit files for processing using drag and drop, follow these steps:

1. In Workflow Designer, select the target workflow (which must be active) to display 
it in the Workflow Design workspace.

2. In Windows Explorer, navigate to the directory where the file or files that you want 
to process are stored.
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3. Select one or more files and drag them over the origin action in the workflow.

4. When the origin action highlights (displays a bright green border), drop them onto 
the action to submit them for processing.
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Vantage displays a confirmation dialog when all jobs have been submitted:

Click OK to dismiss the dialog; then display the Job Status workspace to track your jobs.

Submitting Files via the Submit Button
To submit a file to an activated workflow manually, follow these steps:

1. Select the target workflow in the Workflows panel.

2. Click the Submit Job button as shown below.

In a multiple origin action workflow, Workflow Designer displays a dialog that lists 
the origin actions. 

Click the Submit Job 
button to select 
media files for 
processing with the 
selected workflow.
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3. Select the action you want to start the job, then click Next to continue.

For a multi-file workflow (for example, a Receive-based workflow that expects more 
than one file), Workflow Designer displays this Submit Job dialog:

Enter or browse and select the file for each nickname and proceed to Step 6. 

For a single-file workflow, Workflow Designer displays the Submit Job dialog:
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4. Select the type of file system (or a Vantage folder) where the input file or files are 
stored, and click Next.

Workflow Designer displays the Windows Explorer window:

5. Navigate to the server and directory, and select one or more directories and/or files 
for processing and click Open. Click Browse to add more files or click Clear to start 
over. As you select files, they are added to the list:
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6. When the list is correct and you’re ready to submit them, click Next. 

7. Optionally, click Variables to manually add variables with values for this job. The 
variables must be identified in actions. These variables are initialized to the default 
value of the variable definition in the domain, and the value may be changed by 
actions in the workflow. For details, see Utilizing Variables in an Action.

8. Click Submit to submit the file(s) for processing.

Vantage displays a confirmation dialog when all jobs have been submitted:

When you have submitted the job(s), you can view their progress in the Job Status 
workspace (see Monitoring and Managing Jobs).
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Submitting Multiple Files in a Batch
To submit a batch of files to a workflow for processing (which starts a new job for each 
file entry in the workorder submitted), you use a Workorder action as the origin action 
in the workflow, and you create workorder files (a CSV file) to identify those files you 
want processed. Next, you can use any method you like to submit the file for processing 
to the active workflow.

The Workorder action enables automated submission of multiple jobs in batches. For 
example, you can use a workorder-based workflow to process multiple media files, 
without manually adding the files to a target directory—instead, you just submit a 
workorder file, which contains a job entry for each media file you want to process. The 
Workorder action initiates one or more jobs each time a new workorder file is 
discovered (based on the number of job entries in the file) and passes control to the 
next action in the workflow. Workorder files must be conform to the schema specified 
in the selected workorder scheme. Workorder schemas are created in the Management 
Console.

Workorder files are a simpler, automated submission alternative to job submission via 
the Vantage SDK. A Workorder file is a text file containing one or more work orders, or 
job descriptions. The format of workorder files is CSV-based. Each job description is 
comprised of a fully-qualified reference to one or more media files, attachments, plus 
variables-all the input needed for the workflow performing the processing. At least one 
workorder scheme must be created (either directly in the Workorder action or in the 
Vantage Management Console) in order to properly identify the workorder schema and 
submit the jobs in a Workorder action-based workflow.

Jobs may be of any type, including Post Producer jobs, where the job identifies a CML 
file for processing. (Post Producer jobs require a special license.) While workorder files 
may be manually created (in an Excel spreadsheet, or a text editor of some kind, for 
example), ideally a system component responsible for submitting media to Vantage for 
processing will dynamically and automatically create workorder files and deliver them 
to the target share for submission and processing.
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Monitoring Workflow Status & History
To check on the status and history of workflows, use one of these methods:

• Choose a workflow and click the Monitor Status tab (or select File > Monitor Status)

• Display the Domain Monitor Status tab (or select File > Domain Monitor Status)

• Display the Domain Summary tab.

The monitor status panels are useful when you’re performing operator-related tasks or 
when you’re managing or performing domain-wide production media processing. The 
only difference between the two tabs is one of scope.

The Domain Monitor Status tab displays all of the workflows currently active in the 
domain. Because this tab’s focus is domain-wide, it also displays two additional 
columns of information not found in the Monitor Status tab: Workflow and Category.

The Monitor Status tab displays all activation records for the selected workflow, 
indicating the dates and times when the workflow was active. 

The Domain Summary tab displays active workflows, and the number of jobs by 
category, including totals. 

Each time a workflow is activated, a new activation record is added. It displays each 
origin action’s execution (for example, Watch actions) in the workflow, and indicates its 
current status.

Static information in the activation record includes the origin action, state and status, 
source location, and several date/time stamps, including when the action will expire. 
The state is real time information, indicating the state of the action: In Process 
(currently executing), Completed, etc.

Click any column to make it primary, sorting it in ascending/descending order.

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar
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These topics provide information on using the Monitor Status tab:

■ Using the Monitor Status Toolbar

■ Viewing Origin Action Record Details

■ Viewing the Monitor Status of Camera Ingest Actions

Using the Monitor Status Toolbar
The Monitor Status workspace provides the following buttons in the toolbar:

• Show in Groups button —Click to organize records for the selected action by 
group, based on the primary column—the one selected. Click again to turn group-
ing off. For example, if you select State as the primary field in the table and display 
Groups, Workflow Designer sorts the records by state: In Process and Complete. 

When displayed in groups, click the Down arrow on the table entry to display the 
origin records in this group (In Process, or Complete, for example).

• Delete button —Click to delete the selected record(s). Or, right-click on the record, 
and select Delete. You can only delete records whose origin actions are complete—
that is, the session has ended because the workflow was deactivated.

• Status button —Click to display the selected workflow’s origin action details. Or, 
right-click and select View Status.
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Using the Monitor Status Context Menu
The Monitor Status panel’s context menu includes these commands for controlling 
completed or in process monitor actions:

• Delete—Choose to delete highlighted Complete monitor sessions.

• Disable/Enable—Choose to disable (pause) an In Process monitor session. Select 
Enable to activate the monitor session again.

• Process existing files—Choose to enable one-time processing of existing files in the 
monitored location. This feature supports submitting all content or content limited 
to the last specified time range (last x minutes, hours, days, weeks, months, or 
years). 

• View Status—Choose to open the Status/History window showing the status details 
about the selected monitor session.

• Open Monitored Folder—When the selected origin action is monitoring a Windows 
directory, choose to open the monitored folder. 
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Viewing the Monitor Status of Camera Ingest Actions
For workflows beginning with a Camera Ingest action which has been configured to 
monitor multiple locations—a card reader with multiple drives, for example—the 
Monitor Status workspace displays additional details.

In the status column, you can determine the number of shots being processed—as well 
as incomplete shots where the action is waiting for files before submitting the job. The 
Source column identifies the location—for example, drive letters on a card reader.
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Viewing Origin Action Record Details
To display details about the origin (the first) action for the selected workflow, double-
click the row (or select a row and click the Status button ).

The Status/History provides details about the status of the origin action.

When an action is complete, the Status/History dialog displays information on each 
aspect of the action’s execution. You can use this information to review details about its 
execution, and when an action fails, you can use this information to determine why and 
correct the problem.

The text in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

Click the symbol to the left of the summary lines in the upper panel to hide or display 
subordinate summary lines.

When an action is In Process, (Queued, Paused, In Process, or Waiting states), the Status/
History dialog displays a progress bar, the path of the target directory, and the status.
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For jobs in the post-execution Success, Ignore, and Failure states, the Status History 
dialog displays the following buttons:

• Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, 
or export them for processing in other systems.

• Session Log—To display a session log, select a session in the upper panel and click 
Session Log:

The session log displays session activity entries for the action, including which 
ComponentPac version was used and which variables have been provided to each 
action. This information can be helpful when debugging the use of variable, or when 
working on an issue with Telestream Customer Service.

Export Variables—Click to browse and export an XML file listing variables passed 
through the action. 

Select
Click
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Monitoring and Managing Jobs
To monitor and manage jobs, display one of these two tabs...

• Click the Job Status tab or select File > Job Status

• Click the Domain Job Status tab or select File > Domain Job Status

and select a job in the table to view.

The Job Status and Domain Job Status workspaces each display a list of jobs and 
provide job details. You use these workspaces to monitor media processing, set 
priorities, view binders and associated files, and to pause and resume jobs in progress.

Note: The Domain Job Status panel displays only current jobs (Active | Failed | 
Stopped | Waiting) by default. To display completed jobs as well, check Include 
Completed Jobs in Domain Job Status in the Vantage Management Console > Settings 
& Options > General.

These workspaces are useful when you’re performing operator-related tasks or when 
you’re managing or performing domain-wide production media processing. The major 
difference between the two work spaces is one of scope.

You use the Job Status workspace to select a workflow in your account and display all of 
this workflow’s jobs. The Domain Job Status workspace displays the jobs currently 
executing in the domain, plus completed jobs if the Include Completed Jobs in Domain 
Job Status options is enabled (Vantage Management Console > Settings & Options).

Each row is a job processed by the selected workflow, indicating 
status and other details.

Job Status toolbar Real-time view of transaction processing



Monitoring Workflows and Managing Jobs
Monitoring and Managing Jobs

30

When an action is executing, it displays a green border, and a progress bar displays at 
the bottom of the action, indicating execution progress. This indicator provides a 
relatively accurate prediction of how far along the total execution has progressed.

You can perform these tasks directly on actions in the workflow you’re viewing:

• Status—Displays the Viewing Action Status and History dialog.

• View Binder—Displays the job’s binder. Or, right-click an action or the job row in the 
table, and select View Binder. For details, see Viewing Binders and their Assets.

• Session Log—displays the Session Log window with execution details:

• Priority—Displays the Action Priority dialog, where you can specify a priority value 
for this action, which controls its execution by stack-ranking it against other actions 
being processed by the same service. 

• Restart—If a job was stopped or it failed, Vantage re-starts and continues process-
ing the job where it was stopped. Actions that fail or are stopped are re-executed. 

The progress bar indicates progress for this action.



Monitoring Workflows and Managing Jobs
Monitoring and Managing Jobs

31

•  Pause—Halts execution of the action without stopping the job. see Pausing and 
Resuming Actions.

• Show in Workflow Design—displays the Workflow Design workspace without alter-
ing its activity state. 

• Edit in Workflow Design—displays the Workflow Design workspace and displays 
the Workflow is Active dialog so that you can de-active and edit the workflow, or 
view it in read-only mode.

These topics provide additional information for using the job status workspaces:

■ Viewing Workflows and Actions in Detailed Action View

■ Using the Jobs Table

■ Using the Job Status Table’s Toolbar and Context Menu

■ Stopping All Jobs in the Domain
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Viewing Workflows and Actions in Detailed Action View
Whenever you are viewing a workflow or job (via the Workflow Design | Job Status | 
Domain Job Status tabs, you can view the individual actions in detailed action view: 
select View > Detailed Action View. The information that displays depends on the tab 
you’re using:

• Workflow Design Tab: Each action in the workflow itself displays the details (nick-
names, variables, run on rules and perform on settings), as specified by your current 
configuration options, plus the description, directly on the action.

• Job Status | Domain Job Status | Workflow Analytics Tab: Each action in the 
selected job for this workflow displays its state, relevant dates, machine, and 
resource cost), as specified by your current configuration options. directly on the 
action. For the life of the job, during task execution, the action may pass through 
many states in real time; after the job terminates, only post-execution states are 
appropriate.

To view actions in detailed action view, select View > Detailed Action View. In this view, 
each action displays its state, creation and update dates, and s directly on the action.

Action States During Execution

Note: At any time before an action starts executing, it may be re-assigned (re-
balanced) to another service which can execute it.

During job execution, each action in the selected workflow displays a color-coded 
border to identify its current state in real time:

• Green—In Process. The action is currently executing.

• Blue—Completed with Success. The action is complete, and performed the task 
successfully. For actions whose state can be manually set, displays the appropriate 
state based on the configuration specified.

• Red—Completed with Failure. The action is complete, and did not perform the task 
successfully or an upstream action failed, and represents the failed state of the 
workflow itself. For actions whose state can be manually set, displays the appropri-
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ate state based on the configuration specified. This action has failed or an upstream 
action failed, causing this action to not execute, and replicate the failed state.

• Black—Ignored | Waiting on License. This action completed without executing 
because the incoming state did not equal the Perform On condition, thus prevent-
ing it from executing or it executed in some exception-processing way (action-
dependent) because a required license was not present.

• White—Idle. The action is ready to execute pending the assignment of a service to 
execute it.

• Yellow—Pending or Waiting for Intervention. The action is ready to execute pend-
ing the availability of the required resources or execution was interrupted for some 
other reason where the service requires intervention from a user. 

Note: A yellow action title does not reflect the state but indicates a “technology 
preview”. These actions can be tested and used but are not yet officially released or 
recommended for use in production applications.

• Light Gray—Paused or Suspended during execution. The action has been paused 
by a user or suspended by a higher-priority action.

• Magenta—Stopped by User. The action was stopped by user intervention.

• Light Orange—Open Workflow Error. A failure is expected when the upstream open 
actions complete.

• Orange—Waiting to Retry. The action attempted unsuccessfully to execute to com-
pletion, and is currently waiting to re-execute.

• Purple—Waiting on a Service. No service of the required type is running that can 
execute the action. For example, no Transcode Service is running to execute a Flip 
action.

• Light Green—Waiting execution due to Run On Rule. The action is waiting due to a 
run-on rule that must be satisfied before it can execute. For example, a Flip action is 
configure to execute on a Lightspeed server, but no Lightspeed servers are online.

Action States After Execution
Each action in the selected workflow displays a color-coded border to identify its final 
status at the end of the job:

• Blue—The action completed successfully—final state: Success. 

• Red—This action has failed—final state: Failure.

• Black—This action did not execute—final state: Ignore.

Note: Completing without errors does not mean that the action performed the 
task—an action may be configured to execute only when a previous action succeeded 
or when a previous action failed—thus, an action may complete without errors, and 
perform no task at all.
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Using the Jobs Table
Click any column title in the Jobs table to make it the primary column and sort it in 
ascending or descending order. The Jobs table presents information about the job in 
the following columns:

Job—The Job column displays the name of the file submitted to start the job, and the 
type of submission: Manual Submit, for example.

Workflow (Domain Job Status Only)—The Workflow column displays the name of the 
workflow that is processing or has processed this job.

Category (Domain Job Status Only)—The Category column displays the category of the 
workflow.

Note: Because the Domain Job Status workspace displays all of the jobs in the 
domain, the Jobs table also displays two additional columns not found in the Job 
Status workspace: Workflow and Category. It also displays an Emergency Stop button 
in the bottom right-corner. For details, see Stopping All Jobs in the Domain.

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—an action in this job has been paused.

• Complete—all of the actions in this job have completed successfully.

• Error—indicates that an open mode action recognizes a critical error (that would be 
shown in the session log view), and will fail when the open block completes.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

Progress—The information displayed in the Progress column depends on the Detailed 
Job Progress setting in the Vantage Management Console.

If Detailed Job Progress is disabled, the Progress column displays the percentage of 
actions that are complete at the moment. For example, if you have a 10 action workflow 
and the 4th action is currently executing, Vantage will report the workflow as 30% 
complete.

If Detailed Job Progress is enabled, the progress column displays a percentage value of 
the current amount of time consumed compared to the total estimated time for the job 
to complete. Using the job’s start time to determine how long the job has been 
executing, you can use the progress percentage to extrapolate the approximate 
completion time, assuming the load on the domain remains relatively constant.
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Note: To change the Detailed Job Progress setting in the Vantage Management 
Console, start the console and click on Settings & Options > General Tab to set the 
Detailed Job Progress check box.

Started—Displays the time the job started by date and time.

Updated—Displays the last time the job record was updated (typically, when the job 
ended) by date and time.

Compute Time—Displays the sum of all action execution time for a job. A value is not 
displayed in this column for jobs that are stopped by the user or failed.

Elapsed Time—Displays the difference of when a job was last updated subtracted by 
when a job started.

Expires—Displays the time the job expires, and will be removed from the database 
(along with its binder). To change the expiration period for a workflow, select it and 
click on the title to display its detail panel, where the Expiration period is displayed. See 
Viewing and Specifying Workflow Details.
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Using the Job Status Table’s Toolbar and Context Menu
The toolbar and context menu provide a variety of commands for managing jobs. The 
toolbar is displayed directly above the table.

The context menu has the same set of commands, with the exception of Show in 
Groups and Jobs Filter button (at far right in the toolbar), which is not specific to a 
selected job. To display the context menu, right-click on any job in the table.

• Show in groups —Organizes jobs by group, based on the primary column—the 
one you have selected. Click again to turn grouping off.

• Stop —Halts processing of this job. When you stop a job in progress, each action 
for that job is notified to stop its own transaction. When all actions have been 
stopped, the job is considered complete, in a user-stopped state.

• Restart —If a job was stopped or it failed, re-starts and continue processing 
where it was stopped. Actions that fail or are stopped by a user are re-executed. 
When you restart a job, it is started as a first-time job again. This affects the execu-
tion of retry rules.  

• Set expiration —Modifies the default expiration time for this job. Workflow 
Designer displays the Set Job Expiration dialog—specify a new expiration date and 
click OK.

• Delete —Deletes the selected job row(s). Or, right-click and select Delete.

• View Binder —Displays the selected job’s binder. Or, right-click an action or the 
job row in the table, and select View Binder. For details, see Viewing Binders and their 
Assets.

• View Job Errors —Displays details about errors encountered in the job.

• Create Report —Creates a job report. Select one or more jobs in the table, and 
click on the Job Report button. For details, see Generating Job Reports Manually.

• Jump to Workflow —This button only displays in the Domain Job Status work-
space. To jump directly to the workflow for this job, select a job in the table and 
click the button.

• Jobs Filter —Displays only jobs that contain specific text in the job name. Enter 
the text to begin filtering displayed jobs. Delete the text (or just close the filter by 
clicking the filter button) to display all jobs again.

Stopping All Jobs in the Domain
If you get in a situation where you need to immediately stop all running and queued 
jobs in the domain, you can use the Emergency Stop button, which is located in the 
bottom right corner of the Domain Job Status workspace.

Note: If possible, Telestream recommend using the Management Console to place 
the services in maintenance mode (or the Windows Services Console to stop the 
services) before using this command. 
After issuing a command to stop all jobs, it may take several minutes to complete. The 
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time to completion is dependent on the volume of affected jobs in the database and 
the consequent load on the computers in the domain.

To stop all running and queued jobs in the domain using this button, follow these steps

1. Click the Domain Job Status workspace.

2. Click on the Emergency Stop button in the bottom right corner. 
Workflow Designer displays a warning dialog.

WARNING: The Emergency Stop button stops all active jobs in the domain, and 
can not be reversed. This will lead to a potential loss of work and/or data. You 
should only utilize this command in an emergency. (For example, mistakenly 
submitting thousands of jobs.) Ideally all services should be in maintenance 
mode before executing this command.

3. Click Yes to Continue.

Workflow Designer issues the Emergency Stop command to the domain database.

After clicking the 
Emergency Stop button 
to stop all of the jobs in 
the domain, Workflow 
Designer displays a 
warning dialog.

Emergency Stop button.
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Generating Job Reports Manually
You can generate job reports for the selected job or jobs, as comma-separated value 
(CSV) files. You can open these reports in spreadsheet programs and other programs 
that display CSV files, or you can use them in other systems, such as databases or media 
asset management systems.

Note: You can also configure a workflow to automatically generate a job report each 
time the workflow executes. See Enabling Automatic Reports in the Domain 
Management Console.

Each job report is based on a job report configuration you select (see Managing Job 
Report Configurations).

Note: If there are no job report formats, Workflow Designer displays a dialog that 
enables you to create one. Click OK to display the Job Report Manager (Managing Job 
Report Configurations).

To create a job report, follow these steps:

1. Select one or more jobs in the Job Status table.

2. Click on the Job Report button  in the toolbar, or right-click the job and select 
Create Report. Workflow Designer displays the Create Job Report dialog (below). 

3. Select a report format from the drop-down list. (Report formats are created in the 
Vantage Management Console Report Configurations > Job Reports window). 

You can also click the browse  button to display the Job Report Manager window 
(see Managing Job Report Configurations for details). 

4. Choose Selected Jobs or Archived job history. For Archived job history, specify from 
and through dates 

Selected Jobs reports on jobs highlighted in the job list and provides a full report 
including all fields specified in the report format. Archived job history reports on 
historical jobs within the window of dates you specify, including expired jobs; only 
the standard fields defined in the Management Console > Job Reports format are 
included; no custom columns are included.
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5. Select where you want to save the CSV report file for the selected jobs, as shown in 
the following figure.

Vantage displays the File System dialog, which you can use to select the server and 
directory where you want the CSV report file for the selected job or jobs stored, as 
shown in the following figure.

Optionally, enter a new name for the job report file (or append a date or other 
significant qualifier) and click Save to process the report and save the file as a CSV file. 

When the report file has been generated, Vantage displays a dialog to indicate where 
the file was saved. Click OK to close the dialog.
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Managing Job Report Configurations
Two types of job reports are available: automatic reports and manually generated 
reports. 

Automatic reports are set up using the Automatic Reports: Modify button in the 
Workflow Details panel and run every time a job runs. For details see the Designing and 
Managing Workflows chapter of this guide—Enabling Automatic Job Reports. 

Manually generated reports, which you can run on selected jobs as needed, are 
described on the following pages. These reports are configured by right-clicking jobs in 
the Job Status or Domain Job Status panel and selecting Create Report.... 

Note: Completed jobs in the Domain Job Status tab are visible only if the Include 
completed jobs in Domain Job Status selection in the Vantage Management Console 
Settings & Options General panel is checked (enabled).

Before you can generate job reports, you must create at least one job report 
configuration. You can create multiple configurations; one for each type of job report 
you want to generate.

You use the Job Report Manager to create, edit, and delete job report configurations. 
(The Job Report Manager is also available in the Vantage Management Console.)

Note: Reports are set up in Workflow Designer’s Workflow Details panel using the 
Automatic Reports: Modify button, or in the Job Status or Domain Job Status panel by 
right-clicking jobs and selecting Create Report. When checked, the Include completed 
jobs in Domain Job Status selection in the Vantage Management Console Settings & 
Options General panel enables visibility of completed jobs in the Domain Job Status 
tab; when unchecked, only current jobs are shown.

The following sections describe these tasks:

■ Displaying the Job Report Manager

■ Creating a New Job Report Configuration

■ Choosing and Adding Report Columns

■ Duplicating a Job Report

■ Deleting a Job Report
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Displaying the Job Report Manager
To display the Job Report Manager, follow these steps.

1. Display the Job Status or Domain Job Status workspace.

2. Select a job from the Job table.

3. Click the toolbar Job Report button  to display the Create Job Report dialog:

4. Click the browse  button to the right of the report menu.

Workflow Designer displays the Job Report Manager window.

Toolbar buttons:
Create | Delete | Save | Duplicate
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Creating a New Job Report Configuration
To create or edit a job report configuration, do the following:

Note: Vantage domain administrators can also create report formats with the 
Vantage Management Console.

1. To create a new job report configuration, click a job in the Job Status or Domain Job 
Status window, and click the Create a report button. 

Note: Completed jobs in the Domain Job Status tab are visible only if the Include 
completed jobs in Domain Job Status selection in the Vantage Management Console 
Settings & Options General panel is checked (enabled).
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2. Click the Create/Edit/Delete Job Report Configuration button (below). 

The Job Reports Manager dialog opens.

3. To edit a job report configuration, select it from the list, or to create a new 
configuration, click the Create a new report configuration button .Enter a name 
in the Name field.

4. Optionally, enter a report description in the Description field.
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5. If you want to include a header row, check Add Header Row.

6. Click the Save button  to save the new report.

Choosing and Adding Report Columns
Check the boxes to configure reports to include or exclude the following columns:

• Job ID, Job Name, State, Progress, Started, Updated, Expires, Category Name, Work-
flow Name, Job Run Time (seconds), Job Queue Time (seconds), Media Duration 
(seconds), and Cloud Cost.

• Additional columns for metadata label parameters (not available for archive 
reports)

When you choose to display a column for a metadata label, the column displays the 
label value. To add or delete columns for metadata labels, do the following:
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1. Click the Add Column button  to display the Select Label Parameters for Columns 
dialog.

2. In the Labels panel, select a label for which you want to display parameters.

3. In the Parameters panel, check the checkbox for any parameter you want to display, 
and clear the checkbox for any parameter you do not want to display. 

To toggle between showing and hiding categories in which the parameters reside, 
click the Category button . 

4. Click OK to save the selected label parameters and close the dialog.

5. To change the displayed order of parameter labels in the Job Report, select a label 
in the list and use the green up  and down arrow  buttons to move the label 
up or down in the list.

The top listed parameter becomes the first column after the “standard” columns in 
the job report, and the last item becomes the last column on the right.
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6. Click the Save button .

The Job Report Manager displays your changes. 
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Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All settings in the duplicate report match those in the original report.

To duplicate a job report, do the following:

1. Select the report to duplicate.

2. Click the Duplicate button .

3. In the Name text box, enter a new name for the duplicate report.

4. Make any other desired changes.

5. Click the Save button .

Deleting a Job Report
To delete a job report, select the report and do the following:

1. Click the Delete button .

2. When the confirmation dialog displays, click OK.
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Viewing the Domain Summary
The Domain Summary tab displays, on a per-workflow basis, data for all jobs in the 
domain: In Process, Waiting, Completed, Failed, Stopped by User, and Total Jobs. 

Consider thinking of this as a general purpose or quick report that you can quickly 
examine instead of having to set up and generate a jobs report. The display is static and 
offers no control over workflows, but you can use the Open Selected Workflow button 
or right click context menu to jump to a specified workflow in the Workflow Designer.
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Viewing Binders and their Assets
The Binder dialog displays information about their assets—files ingested or generated 
in a job—or in subsequent jobs, when the Register action is configured to overwrite 
binders if a file of the same name is submitted (Conflict Resolution). Assets in a binder 
can include media files, metadata labels, and attachment files.

To view the binder for the selected job, choose:

• Click the binder button  in the toolbar

• Right-click on any action, or job row in the table, and select View Binder. 

• Double-click the job row in the table.

Viewing Media
The Media Files tab displays a list of media files ingested or created in the job, including 
the file’s path, nickname, and filename. To the right is a WMV player, where you can 
preview the selected file provided that it is playable by Windows Media Player 
(typically, WMV, AVI, and ASF files, depending on your configuration).

You can also right-click any file and Choose these options:

• Open Containing Folder—displays the Windows directory where the file is stored.

• Open With Default Program—opens the file in the program specified as the default 
program to open these types of files, based on its extension.

• View Files List—displays the list of files submitted as part of the job.

• View Full URL—displays the full URL of the file submitted. See Submitting a Remote 
File via the Vantage API for additional information.

The ability to play media depends on the operating system where the file is located:

Local Windows Storage
• You can Open Container Folder or Open With Default Program

• The Player window displays and plays compatible media.
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Network Windows Storage
• You can Open Container Folder or Open With Default Program

• The Player window does not display or play compatible media.

Cloud storage and other file systems (FTP, Aspera, Pathfire, BML)
• You can not Open Container Folder or Open With Default Program

• The Player window does not display or play media.

Viewing Metadata
Use the Metadata Labels tab to display the labels associated with the job, their 
parameters and values. (You cannot edit values in this viewer.) 

Viewing Metadata
The Attachments tab displays a list of attachment files, including each file’s path, 
nickname, and filename.

Submitting a Remote File via the Vantage API
The View Full URL feature in the Job Status > View Binder panel helps API users submit 
files located on remote file systems such as Amazon S3. In particular, the output 
displayed in the View File URL dialog is precisely the properly formatted URL needed for 
an API command addressing a remote file location. 

Note: User Administration must be enabled in the Vantage Management Console, 
and only users who are administrators are able to use the View File URL feature.

To use this feature, follow these steps:

1. Set up a simple workflow, such as Receive and Register, and activate the workflow. 
The purpose of this workflow is simply to register a remote file which represents 
files in the remote file location that you want to use. The Receive action Media Files 
Expected Nickname should be set to Original.

2. Use Submit Job and manually browse to a representative file in the remote location 
and submit it to the Receive action. 
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3. Right-click the job in the Job Status table, and select View Binder.

4. Right-Click the Original file in the binder and select View Full URL. The resulting 
dialog is as follows:

The text of the dialog is exactly the text that you need to cut and paste directly into 
an API submission message to submit the same file to another workflow via the API.   
Refer to the Vantage Rest API Guide (available on the Telestream support website) 
for detailed information about submitting files to a Vantage workflow.

To submit other files in this location to other workflows, change the name of the 
remote file in the URL (boxed in red) while leaving all else in the URL the same. The 
file name portion of the URL is NTSC_TC_CC.mpg. That is the only portion of the URL 
that you need to change to a new file name.

Controlling Action Execution in Jobs
These topics describe how you can control action execution in your jobs:

■ Pausing and Resuming Actions

■ Pause for Priority in Actions

■ Setting Action Execution Priority

Pausing and Resuming Actions
To pause and resume actions in a job in progress, right-click on the action and select 
Pause from the context menu. To resume a paused action, right-click on the job and 
select Resume from the context menu.

You cannot pause actions in certain states or in certain workflows. For example, you 
cannot pause an action that has failed. Also, you cannot resume an action downstream 
of another failed action, without restarting the first failed action, etc.

Note: Pausing an action requires that the service executing the action allows you to 
pause actions, which is disabled by default. To allow you to pause actions executed by 
a specific service, in the Vantage Management Console, display the Services panel. 
Select the service, and in the Setup > Pause Limit panel, check Allow Paused Actions.
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Pause for Priority in Actions
Pause for Priority is an automatic feature of Flip64, Multiscreen Flip, IPTV Flip, and 
Conform actions. If a transcoding service is saturated (performing the maximum 
number of jobs), Vantage will queue up incoming jobs and wait for a slot to become 
available.

For example, a Transcode Service is configured to run 2 simultaneous jobs; it receives 
three jobs (A, B and C); jobs A and B begin execution (the service was idle prior to this) 
and C is queued until either A or B completes, at which point C will execute).

Pause for Priority comes into play if job C has a higher execution priority than job A or B. 
In this case, job A is paused and job C begins processing immediately. When Job C or B 
completes; then A (which was previously paused) returns to processing.

Setting Action Execution Priority
You can modify the execution priority of actions in a running job, when they are in the 
Wait, Pause, Failed or Running states. You cannot set an action priority for a completed 
action in the Success state. 

The value you specify causes stack-ranking of other actions queued by the same service 
(or services) that can execute this action. To change the priority of an action, do the 
following:

1. Right-click the action and select Priority to display the Action Priority dialog:

2. Change the priority value (larger numbers equal higher priority), and click OK to 
modify the action’s priority in this job. (Zero and negative numbers are allowed; for 
example, a 0 priority executes before a -1 priority, and a 100 executes before a 50.)  

Range: -2,147,483,648 to 2,147,483,647. Typically, you will establish a practice of 
setting practical priority limits based on a pre-determined range: 0 to 100, or -1000 
to +1000, for example. 

Viewing Action Status and History
To view details about the status of any action in a job, select the job in the jobs list, 
right-click the target action in the workflow, and select Status from the context menu.
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The Status/History dialog provides details about each aspect of the action’s execution. 
You can use this information to gather details about its execution, and when an action 
fails, you can use this information to determine why and correct the problem.

Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, or 
export them for processing in other systems.

Session Log—To display the action’s session log, select a session in the upper panel and 
click Session Log. You can also display an action’s session log directly—right-click on 
the action and select Session Log.

Click Done to dismiss the Status/History window.
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Using the Job Status 
Views Web Application

Job Status Views is a web application that enables basic Vantage job management via a 
web browser. You can use Job Status Views to access job information and manage jobs 
in your Vantage domain from anywhere on the LAN, or via the Internet if you provide 
such access your Vantage domain.

Note: For information about Vantage web application requirements, starting and 
stopping web applications, and other basic topics, see Vantage Client Programs 
Overview.

Topics
■ About the Job Status Views Web Application

■ Job Status Views Web Application Overview

■ Using Public and Private Views

■ Sorting Jobs by Column

■ Paging Through Job Tables & Setting Page Size

■ Filtering the Job Table

■ Highlighting Job States Row by Row

■ Managing Jobs

■ Troubleshooting
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About the Job Status Views Web Application
You can use the Job Status Views web application to do the following:

• Display information about submitted jobs

• Sort and filter job entries

• Highlight and identify jobs in different states

• Stop, restart, and delete jobs

• Troubleshoot job processing issues

The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. Views may be public or private. Public views are 
available to everyone, and private views are for use by specified Vantage users.

Changing Web Applications Language and Date Format
Vantage Web Applications detect the language and date format specified in your 
browser. For example, selecting English (United Kingdom) as the language displays UK 
spelling and date format (DD/MM/YYYY). Selecting English (US) as the language 
displays US spelling and date format (MM/DD/YYYY).

To change language and date formats, follow these steps:

Internet Explorer Language and Date
1. Open Internet Explorer.

2. Select the Tools menu and then Internet Options.

3. Click Languages.

4. Click Set Language Preferences.

5. Choose your language, for example, English (US) or English (United Kingdom).

6. Close and reopen the browser and access the web apps. Your language and date 
format should be displayed in the web apps.

Chrome Language and Date
7. Open Chrome.

8. Select the “three dots” menu at the far right, and then select Settings.

9. Expand the Advanced link at the bottom.

10. Under Languages, expand Language.

11. Click Add Languages, scroll and select a language, and click Add.

12. Click the menu button to the right of the desired language, check Display Google 
Chrome in this language, and click Move to the top. The language at the top should 
display your selected language.

13. Close and reopen the browser and check the web apps language and date format.
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Job Status Views Web Application Overview
The Job Status Views web application displays the jobs table, as shown here. 

The Job Status Views display is presented in three panels.

To display or hide the title or panels, click the Show/Hide controls.

• Title panel (top)—displays the home button, Vantage domain and user name, and 
controls to manage the user password, change domains, and to log out of the 
domain.

• View panel (left)—displays views that define which jobs are listed in the job list. This 
panel also includes controls to display product version information and this guide.

• Job list panel—Center, right—displays the job list in table format, along with the 
program’s toolbar, which contains command buttons and menus.

Note: If you don’t log in as a Vantage user, private views display None Available.

The following sections describe how to use the web application:

■ Using Public and Private Views

■ Sorting Jobs by Column

■ Paging Through Job Tables & Setting Page Size

■ Filtering the Job Table

■ Highlighting Job States Row by Row

■ Managing Jobs

■ Troubleshooting
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Using Public and Private Views
All views are defined either as public or private, and are created and configured in the 
Management Console. Click on the view to select it, and display jobs for this workflow. 
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows. 
The information that All Workflows displays depends on how it is configured in the 
Management Console, and whether it is enabled or not. If no private views have been 
defined, or if you log in as Public, the Private Views list displays None Available. 

The following topics provide more information on views:

■ About Public and Private Views

■ About View Definitions

About Public and Private Views
Public views are views that the Vantage administrator has made available to all Vantage 
users. Anyone who connects to the Vantage domain can display public views in the Job 
Status Views web application.

Private views are views that are available only to those Vantage users for which the 
Vantage administrator has enabled access. The administrator might configure custom 
views for different departments, users by role, or customers, and limit access to those 
views to the appropriate users.

About View Definitions
All views that you create are based on a specific workflow. In addition to being public or 
private, views limit the information that is displayed and specify which job control 
features (if any) the user has to use. If no controls are enabled, the view is considered a 
read-only view. You cannot create or configure views directly in Job Status Views; views 
are created by the Vantage administrator, via the Vantage Management Console, and 
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much 
information for most applications. For example, it might be more convenient to display 
fewer columns. This view might only display active jobs, and it might disable controls 
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or 
may not be present) in views

■ Displaying Items in Views

■ Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for 
information on how to set up custom views.
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the file submitted to start the job, and the type of submission: 
Manual Submit, for example.

• State—The current state of the job, which can be:

State—This column displays color-coded key words to identify the status of the job:

• In Process—the job is active (being processed).

• Paused—the actions in this job have been paused.

• Complete—all of the actions in this job have completed successfully.

• Failed—one or more of the actions in this job have failed.

• Waiting—the job is active, but is currently waiting for a resource (a service) to 
accept and process one of the actions in the workflow.

• Stopped by User—the job was stopped by a user.

• Waiting to Retry—the job is active, but is currently waiting for one of the actions in 
the workflow to re-execute.

These optional columns can be added to a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Workflow—The name of the workflow that started the job.

• Run Time—Displays the total elapsed execution time for the job.

• Expires—The date and time when the job expires and both the job entry and the 
job entry is deleted.

Controls in Views
An administrator can configure the following controls in a view:

• Enable—Enables or disables use of the view.

• Show Only In Process Jobs—Displays only jobs that are currently running.

• Stop | Start | Delete—Enables or displays the ability of the operator to manage 
jobs—stopping, restarting, and deleting them.
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Sorting Jobs by Column
To sort the displayed job list according to the entries in any column, click that column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.

Paging Through Job Tables & Setting Page Size
A job table may span multiple pages. Use the page size control at the bottom center of 
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first 
or last page of a job list. The figure below indicates where the page controls appear in 
the job panel.

Page controls Page size
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Filtering the Job Table
Job filters allow you dynamically control which jobs display in the job table. The default 
configuration displays all jobs specified in the view for the workflow. However, during 
troubleshooting, you might want to display only those jobs that are in a failure state. 
Other times, you might want to display only those jobs that are in progress.

To display the Job List filters, click Show Filters in the toolbar. The filters are displayed 
directly below the column titles in the job list table, as shown in this figure:

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to 
filter the list. If multiple filters are configured, the job list includes all jobs that meet the 
criteria of all configured filters.

■ Setting the Job Name Filter

■ Setting the Job State Filter

■ Setting the Total Progress Filter

■ Setting the Date and Time Filters
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Setting the Job Name Filter
You can use the job name filter to limit the job list display to only those jobs with a 
name that meet criteria you specify. The following sections describe how to set and 
clear the job name filter:

■ Specifying a Job Name Filter

■ Clearing the Job Name Filter

Specifying a Job Name Filter
To specify a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you 
want to include or exclude from the list.

3. Click the control to the right of the filter text box and select one of the following 
filters:

– Contains—Displays all jobs that have a name that contains the text you specified.

– DoesNotContain—Displays all jobs except those that have a name that contains 
the text you specified.

– EqualTo—Displays only those jobs that have names that exactly match the text 
you specified.

– NotEqualTo—Displays all jobs except those that have a name that exactly 
matches the text you specified.

Clearing the Job Name Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter text box and select No Filter.
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Setting the Job State Filter
The job state filter allows you to selectively exclude jobs from the job list based on the 
job state. The default configuration displays jobs for all of the following job states:

• Complete

• Failed

• In Process

• Stopped By User

• Waiting

• Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State 
column is All States. When the job state filters disable the display for jobs in one or more 
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes 
to define the states for which you want to display jobs.
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Setting the Total Progress Filter
You can use the total progress filter to limit the job list display to only those jobs that 
meet progress criteria that you specify. The following topics describe how to set and 
clear the total progress filter:

■ Specifying a Total Progress Filter

■ Clearing the Total Progress Filter

Specifying a Total Progress Filter
To specify a total progress filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you 
want to include or exclude from the list. The range is 0% to 100%. 

3. Click the control to the right of the total progress text box and select one of the 
following filters:

– Contains. Displays all jobs for which the total progress includes the value you 
specified.

– DoesNotContain. Displays all jobs except those for which the total progress 
includes the value you specified.

– EqualTo. Displays only those jobs for which the total progress matches the value 
you specified.

– NotEqualTo. Displays all jobs except those for which the total progress matches 
the value you specified.

Clearing the Total Progress Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the Total Progress text box and select NoFilter.
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Setting the Date and Time Filters
The date and time filters allow you to limit the job display list to jobs that started, 
updated, or expire within a specified time period. There are three separate date and 
time filters for:

• Started

• Updated

• Expires

The following topics describe how to set and clear the date and time filters:

■ Specifying a Date and Time Filter

■ Clearing a Date and Time Filter

Specifying a Date and Time Filter
To set any of the date and time filters, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label 
box displays Custom.

3. In the panel that appears, click on the calendar and clock buttons to set the date 
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the 
To date and time. If you omit the period To date and time, the program displays all 
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter
To clear a date and time filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box.

3. Click Clear.
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Highlighting Job States Row by Row
Job state highlighting allows you to use colors to make the different job states more 
visible. Or, you can use the same color for all job states to draw less attention to the job 
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar. 
Each time you click the button, the job state highlighting changes from the current 
state to the opposite state.

Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.

The following topics describe how to stop, restart, and delete jobs:

■ Stopping Jobs

■ Restarting Jobs

■ Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.

Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.
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Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do either of the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.

Troubleshooting
Job Status Views enables troubleshooting and correction at the job level. For more 
comprehensive troubleshooting, use the Vantage Dashboard web application.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.

• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?

• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as described 
in Stopping Jobs. Once a job is stopped, you can try to restart the job or delete it.
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